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JIOFEEL, NV T & SEHRSEE, po< Y EAICEL THET 5,

B) A FHE /725 0.15MPa O34, 0.15X1.1=0.165MPa TR&ERBRZ1T 5,

@ FEBN vy FROH 2G0T (V-GOO) Z2FE<,

® HlEEEOIGTR A A » F CHEME BT ) 2175,

©® AWRH APR Offilfl=> ~® OPEN R ¥ > 2 L7-tk. OUT R¥ v & L C, BEDE
N &EHERT 5, (APROFRRIZ, ¥—YHETkPa ThD)

@ AR LW 256, A APRL,2  OPEN (7 %,

vAT7un—ay ba—7—0OREERAKD 100mlU/min (2 L THT, R 2 WHIET &
FFEEEE THEAMN EA3D (80~6047) &, IR ETNIE~vAT7r—a3 ha—F —0Djfk
wmNIEE D,

© BT AWIESR (RV-O0) Z22HMAICE L T7 U —I2T 5,

13



O SSH ABIESR 2 WAIDOE & P — (PIT-O02) OES) % idéxd 5,

@ 10 5%, [Ehtr¥— PITOO2) OEINEIET =v 7T 5,
EHT LT RAEZHRE LI TDT A T 2RIEMOKERREZITO), Ty 7 — MK
JEH AR R 2 WROIES | Y — (PITOO2) D&tk d 5, (F=v 7 15)

(RERBRBTERVEE)

O EB Ny FRNOHRT A 3T (VV1) 2B 5,

O AR AR v 7 ANO G AEF (RV-OO) 245128 LT, 2 WIRIE ) % 325k
Re DM R ESICFATTT 5,

© EHoN o THO T AHE LT (V-GOO) #BAL,

O HIEEOMIGTAAL v FTHEME (k7 7)) %179,

@ ~A7r—ar tr—T7—0OfiE%xHEAD 100ml/min |Z L TH 7,

O BEHAEFLRND, [IAREIC X DELE L ORIREEZTT ),
AT DA LERE LI TOT A U CRBEROREBERREITH, (F=v 7 15)

3-5-3. EEE/N—D
Ak, BLENITRT2—F =R R—= L TR T THIN., an-OiENE %EHE Tl
7o, BEPIZERRKT VN E-> TWD & BENTOBRENETT 5, BED/ \—
X, BEITA L EFERAT AT RAZEGE L2 TDOIF4 > TITH,

O REHATA v ORBERBPIKET LI, FBRNy FNOPRT A 2T (VVL) %
FTHEE->TCWEEHREETT,

@ MHIHEARDOYER I A A » FE2BERIEGR T 7)) LT 2 RIME & ET 5,

@ 2 WMIEFIA 0.01MPa LL Rl » 7= bHERAEAERE R v 7)) +5,

@ HARASUENA v 7 ANORE A ARESR (RV-O0) ZA4IZE LT, 2 AE S % £ 4
J£7) (0.1~0.15MPa) (ZFHEi+ 5,

® HIEBROPER AL v F2BHEE (&7 7) LT1IREZRET S, (EHT AR L
7 (V-POO) 23BAVTWS 2 & 2 HER)

® KISHABESR RV-OO) O 1RAESE > — (PIT-O01) OEHMEFLTWL Z
L EHERT D,

@ RISHARESR RV-O0) O 1 RMEHE S — (PITOO1) OERE oy, 2k
BIEAMET Lihd 7= 6, JERF LG ORIEGR 7 > ) &tT o -t BEBHR T AEE
7 (V-POO) =L 5,

® MISHARESR RV-OO) O v7EEIZEILTYZ U —I2L, UT HEZEMHRT 1 > H
N7 (V-OP2) #BA<,

@ HAR AR v 7 ANDOEFR T ARG Sv7 (VPOD) #BEL,

O A APEF (RV-O0) ZA4I1CE L THERES (0.1~0.15MPa) 1ZHREE L, fifae % B
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BIEGEZ v T 5, TO%, ~AT7r—ar hr—7—O§i&E% 100ml/min 2L T, i
BNV ERIKLY v My (10 551D 179,
@ ~vA7p—aryhe—J—0Df&xErIilT 5,
@ HARARUGHR v 7 ANDOEHE D AMHE v (VPOO) 2L 5,
@ UITHERIGE T4 A LT (VOP2) 2L 5,
T BRI A U T ARGHESR, ERELVZBEBLTN—UEITH 2 8,

FOSPEAT ZAHEHE T A > D N2 8=V %475, (F=v 7 16)

@ FEATHEFXY VT HATA (NI TLHA - EBREHA) OTRBLO 1 kAL
(V-Hel - V-N1) #BiF %,

@ 2 WERTHBEENTWDEHER L, S TWARWESITESR RV-He - RV-N) T 0.1~
0.15MPa |2 &) &35 5,

QWENTEINTWDEGAEIE, TOFFE 2 &MLV T (V-He2 - V-N2) BT 5,

@ EERN FNASFLDOND 7 LT ARG LT (V-GHe) + EHE S AiE /L7 (V-GN)
B <,
He RN« N2 AR _D 1K, 2IWEZHER L, T=v 7 — MIFRAT D,

(F=v717)

AP 258 MFC1,2 Ofilffl== > ~h® CONT L T, HRHEREL IR,
ERTHEIRDA LT F U AAAL »F % OFF (FMX) 2L, 4% —nmy 7 alEst
2o
HENEGRE S AT L% ON (JHT) 127 %,
A > —vv7 ON Offs, BENEGE S AT A ON OfERZITV, = v 7 — MR
AT %, (F=v 7 18)

3-5-4. NILT Vv B —DERY T

O PRI A BRBEIEGETZ > ) LT, FEBrNy FTRNO T AEHE L7 (V-GOO) £ TOREN
DEFREYRT D, ZORE, AR APGHAAR » 7 ANO 2 RAIES & > — (PIT-O012)
ZREER LR S 0.01MPa UL FiZ7e » 7= HHER S 2 EEGR T > ) 5,

@ FEBNy TNOETOH A LT (V-GOO) BEAE - TN D 2 & 2R 5,

@ AR Ry 7 ANOETHO,9L7 (PO, V-OO1) BHE->TWE Z & &R L,
PAE > TR ITHUE® %,

@ TARNWHIAR » 7 ANOFOEA ZES (RV-OO) ZZICEILT7 U —IZ7T 5%,

© I OREG I T — AL v FERFUIC L, BEih AL v F2HBEGET o 7) T 5,

® RROEENANT % v B—DRRTZ o TEWOMNT, 77T FvaEDd Lk
OITHEDAHT 5,

D »IVT U v X —RIERPNR o ROTERE N RSBV TREEIZ 2> T0D 2t %
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[ T )
PIVT VB =Dy NUN—DFhEhTF vy 7T 5ENTHMEETH X BT
Do
¥ EQY BNkt Elry 7 eV E X, By U AR—2FHEHL IS, N R

NESLEILTOLFLREL, BEEY b AA—D2FhL &5 & BT 5,

@ A oV —F—0apRE TERAARAT) okt IR E] 12725 F Ty RVE R

FHEID ICH 1 R S E 5,
M R NESHERDEZED TE SERFEH LR NTRITHERICE Y L%, ARG S
QL Z LoD LD D,

@ NPT T TN RvELonh EfED 5,

@ 2y FLR—D2FEAHNLTFZEEL, WEFO L REDNFHOHD ENDZ L EHER LN
(BAEE 8 | 1272 D £ CTKEFRIEIV IZ Y RAERET, ZOEE, NLT vy v X —DA v
U= — I L ERICED D,

MO BEENE S KA L, KEGRTH 5,

@ HIEREORIITI AL v F2AEEGRT ) L, THRNBH LS Z & 2RI 5 (FBEHER) .
W NN T ¥y F—ONy RVEREL RFHE D ICOR D 2208 b ARIKE R _XOJeke s R
IV B SERITIEWTIRREIZ T 5,
® HIEEEDO BRI AL v F 2 REEGET > ) L, BEO~BDFIEZITV., TR 2T 5,
@® HAR AR v 7 ANDFOSH AJgEF (RV-O0) ZfEHES) (0.1~0.16MPa) (2
AT 5,
@ HARANUR v 7 ADBREZHD ThisE L, AR v 7 S TWDH I L 2T 5,
@ FIEEOMAAFRBTRTIVEBICL T —2FHIC L, W TRET S, Famhd—
2L v FHRRICHERA L, ¥—2RET 5,
NVT v 2 =50, BEfRE T2, (F=v 7 19)
AT AR RO 1RE, 2REEZTF = v 7 > — MIEEATD (F=v7 20)

3-6. EBR
FRANX, Eh~y FNOHT AMEHG L7 (VVGOO) X0 T fFRELE NIZZE5E Tlilic
ENTVDEOT, YN KFTEE(100em FLE) T Q-MASS THER LN bt LT =N E
(A%

> FEBRHIL, EBRANY THROFENV LT THAOHE - 212175 2 &

> 2WMIENZ, FHAZP LIRS T AR ANEHAR v 7 ZAD RS AEFR (RV-O0) %
MW %,

> EHAGH OGS Y =2 TV EGI L, EEHEWRAEIIEDEVTHISTH T L,

BT, ROSEBENIILNTRIEET A CERE (1564500 E) LTrbiTHZ

> RBIRHE, ELVOBIPIBEICHAE > TCVWAZEEHAB L THLRIGHT A ﬁfﬁ‘?‘; L,

A\
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<EBRERTH : RUR—KREDOHEZ >
EBIETIRICIX, 1 RENEZ T = v 7 >— MIGRAT D, RO 1 RIEOHRED D HER
EXNRHAFEOTAEREEZHE ML, Ty —MNIRATS, (FzvZ 21)
1 WEDRA D 0.2MPa L FOSBEIX, &L (20 U v b)) X (RE) &35,

3-7. RUROEY 4L
M AR ARPINR » 7 ZADOJIEFIL,. HAFEHEO F FIRFFL TEB L,
XOZOBEBETIE, EFEARCNEER A ST, EEEIC ORI TR 2L,

3-7-1. ARADOEHKEZEFLT D (RUORTHZRAL D),

O R ORGwTIRF—, aHRl L0 F—2 =7,

O FauipF—%2 RSN L, Basonit A4 v T 2 EE L L 2 BEGR 7 )3 5,

@ HIEBEN OPERRE A T F v A AL »F & ON (LHX) 127 5,

@D NVT Xy B DR NESTER D EFZD TE I EHME L, ok RANBFERIT

FWIRRBICT D, NV RVES L, RIKZEDY 449,

® RN EBbALEAE>TWND Z & 2R T 5,
ZOKE, R RO BFEERNLDIZEET D, TRVBHE>TWND Z L 2T 5,
(F= v 22)

3-7-2. HREEICEEEZ/\—F 5,
BT AL L OKET ATV EZB L TERENOT A 2R T D, BLOBEREHAL
FHICTWD 2, ETi LI2WH 2 DRLE DR S LTV D e T %, (F= v 7 23)

BT > TWD T A, RUNEF CIREDIRWAT AROT, =K"=V 5 &
BradbE CRE L N PICRIMER T A VSN D ATREMER H Y . JER T A VIR T
S — ANRMTIBNND D, HERTA DT T — A, — FE{THIIR - A—L
DO DOBRGEMHE A ML) AR E AR SNDHDOT, —RIINRX—=UTH5DTERL, £
B CRBR R LR KR PO LFBREDRFEDHIN L 7250T, ERA—VIE
VT HATH 2k

BEREE (R _~EFRO 1 RA (EE) HREFRO 2 REI~EBEL) 12> T
HH A HABBIZE LV ZB LN LHERT D &,

O FEBHNYTNOPERT A L7 (VVDEZH LT 6T 5,

@ AR T A DS Z 1D TOLEHI#El =~ =~ b CONT z#f L Tiftis 2 B4 %,

@ Ml OGS L OHERIr T — 2 NS EEIC L, SR O MG 2P C Tz b5
BIEGRZ v ) EAT D,

@ HAGBGEFEH L TWDLGE, LW H AR AL EZ@D LI =HRa@End,
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® W LI-WAH AFEOF 4 100ml/min 12 L CEAZE L TR T 5, (1 AT H)

% H2S, CO, NO, SOz #flif L7=36, BE IR T D mlth A Z BREEE S FRE Al
BER LD ITHER T A v DT AREEICIEE LR LT,

X BN ABLOFES A THARIEST 2 TH2RWT ZADOEAT, HIEROYER A 2B
TTHDDEEEM Y IE L TR T D, %A SRR ENTND Z L IEET D,

® BOSAAWESR RV-O0) @ 1 &FIOESI2 OMPa (2 R o721k, HAMRENIZIX 0 12
ol b, HIEEOBHER ZBERE ORT V78T 5,

@ FARWHHR » 7 ANO RIS ARESR (RV-O0) #LIZELTZ U —I2T 5,

® UIT BEHMETA A LT (VFOP2) 2% 12BT 5,

Q@ HARAUIR v 7 ADER T AR L7 (VPOL) AR, EHEAR R 2
WRIE 2 B H AR o ~S#ASE 20T 5

O ISHABESR RV-OO) O 1RBEAN L7+ 2 L x2EHErD— (PIT-OO1) T
R 5,

@ TAR AR v 7 ANOFOGHT AJdEF (RV-OO) 2 41CE LT, 2 kEE 0.1MPa
FREEIZT D,

@ e oMtie 2 BERE kT 7 RAT) 5,

ME% 100ml/min UL FIZ LT, |ERX—T%1T9,

O HFHAMIET AT v ABLE (D7 &b 1HFH, QMASS THER T A &l L
BRINHEADTHET) OERTAZW LI, fliRoOMEREZHA L v AT7r—a
n—7—Dfigrtulld b,

@ FARNTH L TO~®% Y KT,

® AR EHH L CWDEE, W0 =JFf% OFF (23 %, APR O EMIL 0 ThlS
o s s,

© HIEBNORER A T F v AAL vF % ON (E@\x) (27 %,

FrFRALFRLE & D% 0 A MFC @ CLOSE R4 &8 L, #2350 A A4 DE
AL v FOF—% OFF fIZE LT, ERTADHGEZ LD D,

&) EE Ny FHNOPRT A 7307 (VV1) 2L 5, % ZZETPNIETREEZHALTHR
VY,

@ AR AR » 7 ANOFOSH ZFEFR (RV-OO) Z24IZEILT 2 RIEZLZ 0.4MPa
IZREET 5,

@ HARAIGHAR v 7 ANDERMEAE L7 (VPOD) 2L %,

@ HEEOPER A OBBABREELZ TIE0AT I, XA RNRAT A IRMEDRND Z LI
BT 5,

& BUSH ARESR RV-OO) @ 2 WAIE 23 0.01MPa LA FIZ72 o 7= & il il O HER 5 % B
BIET D R7 7).

@ HARAIGHAR v 7 ANDEFRMEAE L7 (VPOD) ZBT 5,

&) @~ % 4 [k IRT,

8 @~WBEITI,
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€9 W AR AU v 7 ANDRIEHT ARIEFR (RV-OO) /2B LT7 U —Icd 2,

6 fHIEEENO T A g (AT 1~3) DAL TF U AAAL v F % ON (LfE) 1215,

&) HARAUGHAR v 7 ANDO RG-S L7 (VPOO) #BT <, EREZBLEZEIOR

BETAR R EFEE BN,

@ AT BUF—L T Mo THFEEICY v v T E I 1T 5,

& HARANUENAR v 7 ZANO RS AEFR (RV-O0) @ 2 RAIES) % 0.1MPa 12T 5,

& MR OPERI A BREET D (T v 7T,

& 30 B/ \—T &HElT B,

6 IR OPERI A PABET D (RT v 75T,

&) HARNIK L TR~%51T9,
Bl BB A0 - T D EIEARSCEDREROFRN E 725 DT, BHENA—IIILT
+ocAaTo 2k, (Fv T 23)

3-7-3. BE2E% 0.2MPa TH Lt1%,

O FEBANyTFRNOETO/ VT (BT, HERIR) BT TWD 2 & 2T 5,

@ TARYNR v 7 ANORIGHT ARESR (RV-OO) T 2 wHAEHZFAI1ZE LT 0.2MPa
T D,
(FHEERTIX, EBRRF D))

@ HARAUHAR v 7 ANOFOGH ZJEFR RV-OO) #£ICEILT7Z Y —I27 5,

@ HAR AP v 7 ANOERMEE LT (VPOO) %L 5,

® UIT E#EMHT A L7 (V-OP2, V-OP1) #BL 5%,
BlEZERTHEH LU, ZOENETF =y 7 — N EHARSPGHA » 7 AZFEAT
5, (Fx=v7 24)

3-8. HARMBHREEDILILTIF
3-8-1. HIEHEDILTIF
O HIHAENOME %~ OER A > T F U AAL v F 42T ON (LX) 1Tl A4 Ol
AT F AR FEBRSFITT D,
©@ BBEGECATLAOAL vy FEMUTHERT 2 (7 7 RUTIREE) .

3-8-2. BRELEDILLTIF
O v—#%—%&W% OFF (7 5%,
@ MEFOMEEZT = v 7 — NIRRT 5,
@ 717 LDOWEN B0CLLTIZ TR -7 b, PEEE%Z OFF 129 5,
@ KiEDOBERA OFFIcL, 27 L yH—D&E%Z OFF 21 5%,
¥ OEENTALOICT BN D DT, @QUEITAY v 73T,
HlEE A o2 —w Y 7 kR, BRELEOSD TR (F= v 2 25)
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3-8-3. FIRUVIBEE, A REAFARER. HRAYELHL. in-situ RERAES RIODIL TS

O FRUHEEEE D APR O A A v F % CONT 2»5 CLOSE (2810 # 2 5,

@ IR v 7 2ADER % OFF (1295,

© HAREHE D MFC Oit&E% 012 LT, CLOSE 27 %,

@ #HIEAR v 7 2ADER%Z OFF (2§ 5,

® HAGEERD APR OfIEIAR v 7 2 D&% OFF 123 %,

©® in-situ EEHE 5 RIO O&EJR%Z OFF (23 5,

D ERHAFAEIEBEBOFEILT VTP L, T4 AT VA CHEBE ERER RIS TND Z &
w BT %,
EHRN AFIERE | W ARPLBREEE | T ARG, T AU, in-situ ERAE
%5 RIO ONE FIF (F= > 7 26)

3-8-4. UIT AZRARDEMEEL

O UTHZEHZITA O VTH#HAL D,

@ He AR RTA V| BHRERHARLRTA L ONVT LD,
UIT HEH#EH A, He HAR LR BHEH AR OB, 1 KT E 2 RIEOHER
(Fxv7 27)

3-8-5. HRBEHMBDILBLTIF
AR D AA » F % OFF (272 (FANZHIEBANOZ LT DA T T ARL v TF%&
ON(EmZ)izLTHL),

HAAERDOERE OFF 1245, (F=v 7 28)

3-8-6. R I77UDIABTIF
¥ HIEEENOA =2 D% 160.00) 12 L7=H4E. 130.00) 1ZKET,

OIAN]1Z# LT TSTUP) AF RSz & [ENTER] % #19,

OINZ#M LT 1d1-01) ARSI HIENTERIZ#9L 160.00) &FRRIND,

@ 6] BEWETHETI>IEML CEEMZBH ST, [VIT 13) ITEET 5,

@IENTERI Z# L CheE S ¥ T, W IZ R 5 £ CIESClZ#19,
¥ BLOTARVABRREINTHWEIHEIL, R 7 7 v OERZEIL VW &,
P77 H UPS DAA »F % OFF (27 %, CERNCHIBEHENDORY T DA T F U AAA
v FEANTEL)

K77 HUPSOAA vF% OFF 2T 5, (F=v7 29)

3-8-7. RIGEERY DEREME
O Appendix IVZ£#%(Z LT Q-Mass &3 Fif 5,
@ RSEEERY OREES L. HfHT 5.
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3-8-8. RIGHEARAEAKRIBTIRNER
BGHETT AAERPRILIS R T A DM AIRGLZ TERF ) 220 [REEL ) ICEET D,

WEELIZT 2, (F=v7 30)

3-8-9. HRARUNUAR Y I ADRURNERWET S,
JRATE LT, R IEA L=ER, Blob oz~ v 2 A L0 T LEDIRET S, &
LN, EFITHIIY 2K L TR Z L HHEROR L RZTINTHRy v 7S EH 2 L,
Ry~ EREF =y 7 v— MIGREATDH, (Fxvr 31)

HOREZHER, T2y 7 v — MIZOFERNT 5, BENH 725 BL HYHIC

LA
HEET D, (F=v27 32)
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4. ATFHR
4-1. EH R
AR, B AFE BRI, T AREOEH AR EIT .,
HAHER—E P —2 =y hORHE, AR
T AKEE (R, AMBUR A, KB
77
PR
g7l
UPS

XA U H—my ZERRIE, BLLYE F IR IR B OFF AT W T T2 &)

4-2. EMAREZFEDLLGVEE (BRABLWVK ST EHE)

BET A MM DRV E, W ARMEGEZEHT 2083, L, o=y &2ty i
FPICHIEEOER A AND & HARAMEBEIEOER B DO T, LLFOEIEEZIT I,
O HIEHENO B AREgE A T FV AAAL v TF % ONIZT D,

4-3. HzS. NO. CO. SO #Eh%VEE (BRBEEZFEDLLEVGSE)

Ha2S, NO, CO. SOz Zfib72\WiEE1E, FREEEZEHT 2 0ETE, L, bR
ZEEETICHEROERE AND & BRELEORFERNBHLDOT, LT OEEE1T
O HIEHEORELEBRA T F LU AAL v TF % ONIZT D,

Rl

it

N

o

4-4, HRHRUBEEZFEDOLEGESE

T AFTHULEEE 2 D70 WA, ARE & B I O EREZ AN D & AR
HEE O RN D DT, UTO®REEIT,
O HIEEDOFHEF A T F v A AL v F & ONIZT D,

4-5. REBD%ER

ARBHEfE (ERA—IMIOME) 121X, LFTOLOBRHEIh TN D,
22

AL UHERZ 7 NORIFT L—r R F MEBEFTIC U TO L ORHE ST\ 5D,
NT—a— W SEAZE IR
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Appendix I
- VT A TR
1. ABULEH N2, He RN ~4L5

N2 A~ He 7" o/~

2. UIT N2 R ~_G8H

\ . B \ Nyt
TRPER N2 Bo~ | & | apsik il N2 Ry~ [
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H AR ANPAR » 7 A
\

fasii]
T

AR AR IR > 7 A SRIME T AR o ARIHIR > 7 A

HEdE

&

PIT-P=A %‘g

bl ]
bl
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Appendix I

Ml = ~ OEEHE  Part 1
1. BEFR

W A7 > 71t PAC-D2

BIRAA v T

TA4AT LA

FDBEN S T AREIEE (BIRA A~ F 3%k DNO v A7 —ar frn—7—(MFC),
02 f MFC., He Hl MFC, # A HREEFERA A » FHHR)O N2 F§ MFC, 4 —F 7L v
Yy —LXaL—F—EZNENGI#ET D, FTOBIT PE-D20 (Appendix MZH),
PAC-D2 7R # 5l
SET A& v+ iREMNT 4 AT L ANZRIT SN,
OUT R ¥ v+ BUENT 4 AT LA LR RSN D,
CONT AR & o+ BREETH A &,
OPEN R & oo« T VA —TF L DIRBEIZ 2 D,

MR TEE CH AT RIS 72 VI ITHEET 5,
CLOSE R¥ v+ HAZIED D,
ALARM RZ v+ 77— ADFREEIT D,
ABIOVWREZ - SET B LN OUT BB W TR EMBE A E T& 5, RAPID A%
EMUBPOEIET S L EmEICETE TE D,
2. BRAEREA

O EFRAA v FEMLTEREAND, A1 v FIXON DG, SUTIREL 70D,

@ CLOSE AR %> ® LED BR< SUT LTV D D& fERT 5,

@ CONT RZ ML THAZ L, SET RZ 2L T, ABLXOVERY VTl

ET D,
@ OUT AR &L T, BIEMEEMET D,
® ALARM A% LT, AL L EERRENTEOHLABIOVRY U TY 77— LAREEE A
N %,
® CLOSE A% %ML T, HAZIDD,
@ EFRAA v TFEMLUCEREYD, A1 v FiX OFF 054, WITKEL 25,

® © 0 6

SHCHNC)

25



Appendix IO
filfl e = s OEESE  Part 2

1. BEFR
T 27w 718 PE-D20

BIRAA v T

BHEHFERT 4 A7 1A

REMERT 4 AT LA

TOBEENDHARAEE (BRAA Tk © H2S A~vA7n—ar bn—7—
(MFC). CO Ji MFC, H2 i MFC, # AFMRIEEGERAA v FRRO~v AT m—RA—
% — (MFM) %ZhEndE+ 5, LT PAC-D2 (Appendix I &[f),
PE-D20 O R % o 3

@ CONT R - HEETHAZEFET,

@ OPENRZ - TNLA—TF L OIREEIT 5,

M EM CTH A Z W RIS 20 L D ITHERT 5,

@ CLOSERHZ - HAZIDD,

@ VWARZ - BEMERD TS, EMLCEEICE T AEE,

® ARK - FEEEZENSED, BML CmlicZs ke,

® SETUPRHY -7 T7—ABLRT VA —UESEDBREEIT D,

2. BRAEREA

O BFRAAL v FEMLTEREAND, A1 vTFIL ON OHE, SUIREE 2D,

@ CLOSE A% v ® LED 37R< AT LTV D D& fERT 5,

@ CONTHRHZ L EZHLTHAEZRL, VEBLOARY V CliiEEZRET D,

@ SET UPAR¥ U AEMUTCREERETRT A A7 VLAIZLFS LRRENTEL, VRX V%
A9, 2.AL £ FR L7725 SET UP R ¥ v &4,

® WEMTFRT A AT VAIZALL EFRSNHETSETUP A% & L, ALSL & F£R
ENEHLABIOVRA L TT7 7 —LREM%Z NI L, SET UP K% v &4,

® BEMPERSNDETSETUP RZ &7,

@ CLOSE A% &L T, HAZIEDD,

® EFHAA v TFEMLUCEREYD, A1 v FiX OFF 054, WITKEL 25,
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Appendix IV
Q-MASS 1 51k

1.

S U R

®

10.
11.
12. -

13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.

28.
29.

CER/ A= el N
5 i Power ON
pump ON
heater ON
C &l ON

7 7' A >4 Administrator, /XA U — R [ZZl] OF F enter TR 7 A >
QUADSTAR 32-BIT => Service ~® ¥ 3 — F#» v b => Measure => total
Pressure
B2EERREE PR RIND  <E-04 TLTEBITONIEREETHD
total Pressure Z ] U %
Service [ U %
Parset ~Dva— Oy a7 U v o

- F ¥ URNVERET H-- Measure => MID => % % k. .mip (GRiTDH DT OK) %
EIN
MID Parametar @ “Detector”# 7427 Vv 7 (BE LWL ZADZTHT Y v 7)
State [ENABLE] Det:Type [CH-TRON| Mass [16.0] < R7=\VE &
“Mass” Dwell [0.2s]
Edit => Sort Mas
File => Save as => £{F
AL %
Measure ~D>¥ ' a— "oy &7 U v
Set up => SEM/Emission control
SEM & Emission (ZF = > 7 # A% Common SEM (X 1900 D F %
Manual => DI/DO=> DOVAIVE1 %2 %77 U v 7 =>0K
MID => Versus Time => 3 %k mip ([12) TREFLTHD) 77 A /LiEIR => OK
E=H—DIEED
File => Save Cycle Date => 7 4 /L% Z{Ea L, * % %k .mdc TLRAF
774/ s TOK  #%Display (2T =7 => OK
Save Measure-Date+Info %7 U v~ Parameters/Date to Save !N Zero Gas Date (/3
NT Z CIeWi% Zero L3 5%) USNF = v 7 or BETF = v 7
RAF7 7 A NVDBIET D
BRAF7 7 ANEKRT T2 File=> close => [T\
= RAFE7 7 A VB HIC Parameter #4589 %-- Parameters => Channel

¥ OPOLBITHRELEZWESIL, —BHEL LI,

32.

- R{F7 7 AN &R\ DispSav ~D a— by b2 Vv
Process => Cycles=> HIE L72(LTW3A)7 7 A /L &#ES % % % .mdc]
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33. — FRMEEHO X BT - Setup => X Axis => Time Relative % 5{R

34. File => Setup => Reload 71 > N7  Automatic Reload (ZF = v 7 # AL %

35. - FREEHO Y fildOZ F--  Ton current [A]- DEFAULT-PKR % & 7 Ti&iR

36. Setup => YAxis=> LoglZF = v 7 ZW\\ LD

37. File => convert to ASKII

[k sk k.asc) ICAMTEHDOT, =7 BLETHS ZENHKD

38. Manual => DI/DO=> VALVE1 #7117 U v 7 => OK

39. Set up => SEM,Emission control => F = v 749 HTFOT7 U 7NHEALTWHI L
7 fifese

40. e —%— OFF

41. 10 53155

42. pump OFF (7 4 7 A2 "R DD & FFD)

43. Ready 23VHAT 74U, O EIR OFF

44.PCvv v hF T
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2007 4510 A 11 H FIK
2007 4= 11 A 08 H kiT
20084 1 H 30 H &G&T
2008 4= 2 A 27 H &G&T
2008 4= 6 H 20 H &&&T
2008 4 12 A 5 H k&T
200942 H 4 H dGT

2009 44 H 10 B c&&T
2009 46 H 22 H o&&T
200947 H 3 H dGT

2009410 H 2 B o&&T
201044 H 12 H T
201046 H 22 H T
2011 410 A 27 H &GT
201245 H 18 H k&7
201249 H 19 H ka7
2013412 H 27 H &&T
201644 H 25 H a7
201841 H 28 H k&7
202247 H 20 H ET
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